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Cue Plankton: Ocean Timekeepers  
 
 

 
 
     
 
FOCUS 
 
Biological oceanography 
 
GRADE LEVEL 
 
Year 9-13 (UK)  8-12 (US) 
 
LEARNING TIME 
 
Two sessions of 45 minutes 
 
LEARNING OBJECTIVE 
 
The purpose of this lesson is to allow students to become familiar with the role 
of zooplankton in the biological pump. Students will look at the process of 
data analysis and learn about how carbon moves in the ocean. 
 
 
 
 
 
 
 
 
 

The zooplankton, 

Pleuromamma xiphias. 

Scientists will take 

measurements and samples of 

this copepod to learn more 

about the circadian rhythms of 

this species. 

Photo by: Kaitlin Noyes 
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KEY CONCEPTS 
 

• Students will learn how to visualize data recorded from a CTD 
(conductivity, temperature and depth device); 

• Students will learn how to measure fecal pellets; 

• Students will recognize why measuring fecal pellets is important to 
understanding carbon flux in the ocean; 

 
FOCUS QUESTIONS 

• Identify the structure of the water column at Hydrostation “S” in the 
Sargasso Sea around Bermuda in May of 2019? 

• At what time and average depth is P. xiphias generating the majority of 
fecal pellets? 

 
LEARNING OBJECTIVES 
 
Students will be able to:  

• Identify the depth of the mixed surface layer 

• Examine the depth where the thermocline, halocline and pycnocline 
begin. 

• Utilize photos of fecal pellets and measure the length and width using 
the computer software Image J  

• Demonstrate the average volume of fecal pellets and identify the depth 
and time when the maximum of fecal pellets are produced  

• Brainstorm about the reasons why zooplankton migrate daily 

• Apply these data the the larger concept of the movement of carbon from 
the upper ocean to below the mixed layer. 
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BACKGROUND 
 
At the base of our ocean food web, microscopic organisms, known as 
plankton, dominate the sunlit layer of the ocean, or the euphotic zone. These 
plankton are plant-like (phytoplankton) and animal-like (zooplankton) 
organisms that play a vital role in the movement of carbon, by way of a 
critically important pathway known as the biological carbon pump.  In the 
euphotic zone, ocean primary producers  (phytoplankton) use the  
energy from the sun alongside inorganic nutrients to transform dissolved 
carbon dioxide (CO2), into organic carbon, through the process of 
photosynthesis. A tightly knit community of zooplankton that live in the dark 
depths of the ocean to avoid predators during the day, make a daily migration 
upward to feed on phytoplankton in the surface waters at night, a process 
known as Diel Vertical Migration (DVM). As these phytoplankton are 
consumed, a majority of the organic material is converted back into CO2, 

through a process known as respiration. Concurrently, zooplankton release 
carbon and nitrogen-based waste products into the water column in the form 
of ammonia and fecal pellets. This entire chemical process from feeding to 
excretion to sustain life is known as metabolism. Although a majority of the 
organic carbon will be taken up in the upper ocean, there is a small 
percentage of carbon that will be transported to depth when the zooplankton 
migrate back to their daytime habitat, where it can be stored in deep, slow-
moving, ocean currents for time scales of months to millennia. Understanding 
these cyclical processes (rhythmicity) and the role that individual species of 
zooplankton play in the movement of carbon and nitrogen in the water 
column, allow scientists to make better predictions of the future climate.  
 
The DVM is a highly synchronized rhythmic event influenced by surrounding 
cues in the environment, such as light and temperature (environmental 
variables). Predictable, daily cycles of fluctuation, known as circadian 
rhythms (CRs), can often prepare an organism for environmental changes by 
regulating their behavior and function (physiology). These behaviors can 
continue to persist under constant environmental conditions, demonstrating 
an underlying circadian clock in organisms. This clock may aid an animal in 
maximizing its survival and ability to reproduce, feed and avoid predators, and 
balance the cost in energy (metabolic cost) needed to make such large 
migration. 
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Drs. Amy and Leo are researchers at the Bermuda Institute of Ocean 
Sciences (BIOS). For this expedition, they collected information on a 
particular member of the zooplankton community at the Bermuda Atlantic 
Time Series (BATS). This plankton, Pleuromamma xiphias, is a common 
migrating zooplankton, known as a copepod. Their research is focused on 
the following questions: do environmental variables effect when these 
organisms move, indicating circadian rhythms?, does this movement 
continue in the absence of these variables indicating a circadian clock? and 
how does the timing of their migration influence carbon and nitrogen 
production and its movement from the surface to depth (biological pump, 
carbon and nitrogen cycling, biogeochemistry)? 
 
To examine this copepod, data have been collected on a 3-day research 
cruise on BIOS’s R/V Atlantic Explorer. Amy and Leo examined how time of 
day and depth influence location and production of fecal pellets that are a 
component of marine snow. All of these parameters are critical to 
understanding the role that P. xiphias plays in the oceanic food web at BATS 
and to improve calculations of carbon and nitrogen cycling that help inform 
and refine climate predictions. 
 
COMMON MISCONCEPTIONS  
 
These data are sampled from one time point and are a very small subset of 
biological, chemical and physical oceanographic data.  We can however 
utilize these data to learn more about the migration and metabolism of P. 
xiphias and display these results graphically. 
 
TECHNICAL REQUIREMENTS 
 
Projector, access to computer with freeware “Image J”, Microsoft Excel 
(optional), internet access 
 
 
 
 
 
 
 
 
 
 
 
 

http://bios.edu/about/team-members/dr-amy-maas/
http://bios.edu/about/team-members/leocadio-blanco-bercial/
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TEACHER PREPARATION 
 

• Teachers will familiarize themselves with the freeware Image J 

• Teachers will be able to effectively demonstrate how to use the ruler tool 
on Image J to measure an object. They will also be able to “set the 
scale” and demonstrate this effectively 

• Teachers will be prepared to move from the graph to discussions about 
how scientists use these data 

 
HELPFUL LINKS 
Image J freeware 
https://imagej.nih.gov/ij/download.html 

 
Using Image J 
https://www.youtube.com/watch?v=xXE7MBiWJIc 

 
What is a Thermocline? 
https://oceanservice.noaa.gov/facts/thermocline.html 

 
How to graph temperature vs. depth data? 
https://www.youtube.com/watch?v=tfW_weLB2J8 

 
What is a CTD? 
https://oceanexplorer.noaa.gov/facts/ctd.html 

 
PBS Changing Seas l The Fate of Carbon 

https://video.wpbt2.org/video/the-fate-of-carbon-2hmfy5/ 
 

The Ocean Massive Open Online Course (MOOC) l The Biological Pump 
https://www.youtube.com/watch?v=hJAWIrJVVkM 

 
Ocean Layering Explained 
https://www.youtube.com/watch?v=TxdiU3LJlZ8 

 
Concentration Gradients 
https://ed.ted.com/lessons/the-motion-of-the-ocean-the-concentration-gradient-sasha-wright 

 
The Secret Life of Plankton 
https://ocean.si.edu/ocean-life/fish/secret-life-plankton 

 
Sea Sketch l The Ocean Carbon Cycle 
https://www.youtube.com/watch?time_continue=12&v=jBFcpwgp-Xk&feature=emb_logo 

 
 
 

https://imagej.nih.gov/ij/download.html
https://www.youtube.com/watch?v=xXE7MBiWJIc
https://oceanservice.noaa.gov/facts/thermocline.html
https://www.youtube.com/watch?v=tfW_weLB2J8
https://oceanexplorer.noaa.gov/facts/ctd.html
https://video.wpbt2.org/video/the-fate-of-carbon-2hmfy5/
https://www.youtube.com/watch?v=hJAWIrJVVkM
https://www.youtube.com/watch?v=TxdiU3LJlZ8
https://ed.ted.com/lessons/the-motion-of-the-ocean-the-concentration-gradient-sasha-wright
https://ocean.si.edu/ocean-life/fish/secret-life-plankton
https://www.youtube.com/watch?time_continue=12&v=jBFcpwgp-Xk&feature=emb_logo
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KEYWORDS 
 
Biochemical respiration: a metabolic process by which an organism obtains 
energy (in the form of ATP and NADPH) by oxidizing (combine with oxygen) 
nutrients and releasing waste products 
 
Biological carbon pump- all those processes in the ocean that cause organic 
carbon formed photosynthetically by phytoplankton (primary production) in the 
sunlit surface layer (the euphotic zone) to be removed from contact with the 
atmosphere. It is a mechanism that sequesters carbon dioxide (CO2) for 
weeks to hundreds or even millions of years (geological time‐scales). 
 
Carbon: A chemical element of atomic number 6 and the chemical 
backbone of life on Earth. Carbon compounds regulate the Earth’s 
temperature, make up the food that sustains us, and provide energy 
that fuels our global economy. 
 
Carbon Dioxide: a colorless, odorless gas produced by burning carbon and 
organic compounds and by respiration. It is naturally present in air (about 0.03 
percent) and is absorbed by plants in photosynthesis. Carbon dioxide is 
a greenhouse gas: a gas that absorbs heat.  

Carbon storage: Carbon is stored on our planet in the following major sinks  

(1) as organic molecules in living and dead organisms found in the 
biosphere;  

(2) as the gas carbon dioxide in the atmosphere; 
(3) as organic matter in soils;  
(4) in the lithosphere as fossil fuels and sedimentary rock deposits such as 

limestone, dolomite and chalk; 
(5) in the oceans as dissolved atmospheric carbon dioxide and as calcium 

carbonate shells in marine organisms. 

Circadian clock: an organism’s innate timing device over a 24-hour period. 
The clock is composed of specific molecules (proteins) that interact in cells 
throughout an organisms body. Biological clocks are found in nearly every 
tissue and organ. 
 
Circadian rhythm: are physical, mental, and behavioral changes that follow a 
daily cycle 
 
 
 
 

https://aslopubs.onlinelibrary.wiley.com/doi/abs/10.4319/lol.2014.sneuer.miversen.gfischer.9
https://www.noaa.gov/education/resource-collections/climate-education-resources/carbon-cycle
https://www.climate.gov/news-features/understanding-climate/climate-change-annual-greenhouse-gas-index
https://www.esrl.noaa.gov/gmd/education/info_activities/pdfs/TBI_co2_and_the_carbon_cycle.pdf
https://www.nigms.nih.gov/education/pages/factsheet_circadianrhythms.aspx
https://www.nigms.nih.gov/education/pages/factsheet_circadianrhythms.aspx
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Copepod: any of numerous tiny marine or freshwater crustaceans of the order 
(or subclass) Copepoda, lacking compound eyes or a carapace and usually 
having five pairs of limbs on the thorax, some abundant in plankton and 
others parasitic on fish (or even in moss or banana trees if there is water!). 
 
Copepod fecal pellets: biogenic particles that are densely packed pellets of 
waste products in which the composition is dependent on the feeding habits of 
the producer. 
 
Diel Vertical Migration (DVM): the daily movement of zooplankton to feed in 
the phytoplankton-rich surface layers while visual predation is inhibited. Light 
is thought to be an important external control with other physical and chemical 
environmental factors such as food availability and predator cues. 
 
environmental variables: factors (variables) that exist in an organisms 
physical environment that influence behavior. 
 
Euphotic Zone: The upper 200 meters (656 feet) of the ocean is called the 
euphotic, or "sunlight," zone. This zone contains the vast majority of 
commercial fisheries and is home to many protected marine mammals and 
sea turtles. 
 
Halocline: a layer of water in which a high rate of change in salinity in the 
vertical dimension is present.  
 
Marine Snow: Aggregations of organic and inorganic particles in the surface 
waters of the ocean, primarily composed of phytoplankton, bacteria, 
microzooplankton, biominerals, terrestrial derived components and detritus. 
As these materials sink, they collects other floating debris, including fecal 
material (poop), dead and decaying animals, suspended sediments (e.g., silt), 
and other organic material that may have been transported from the land to 
the sea.  
 
Metabolic cost: The amount of energy consumed as the result of performing a 
given work task 
 
Metabolism: The entire chemical process from feeding to excretion that 
sustain life 
 
Mixed surface layer:  The surface layer of the ocean water mixed by wave and 
tide motions to produce relatively isothermal and isohaline conditions.  
 
Phytoplankton: microalgae that contain chlorophyll and require sunlight in 
order to live and grow. 

https://www.dictionary.com/browse/copepod
https://oceanexplorer.noaa.gov/fsts/media/Role_of_large_particles_in_the_transport_of_elements_and_organic_compounds_through_the_oceanic_water%20_colulmn_Fowler_Knauer_1986.pdf
https://agupubs.onlinelibrary.wiley.com/doi/10.1002/gbc.20031
https://oceanservice.noaa.gov/facts/light_travel.html
https://oceanservice.noaa.gov/facts/phyto.html
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Photosynthesis: occurs in plants and some bacteria, wherever there is 
sufficient sunlight – on land, in shallow water, even inside and below clear ice. 
All photosynthetic organisms use solar energy to turn carbon dioxide and 
water into carbohydrates (food) and oxygen: CO2 + 6H2O -> C6H12O6 + 6O2. 
 
Physiology: the study of normal function within living creatures. It is a sub-
section of biology, covering a range of topics that include organs, anatomy, 
cells, biological compounds, and how they all interact to make life possible 
 
Physiological respiration: the movement of oxygen from the outside 
environment to the cells within tissues, and the transport of carbon dioxide in 
the opposite direction. 
 
Plankton: floating or drifting organisms with limited locomotion powers. 
Oceanic plankton constitute the largest reservoir of biomass in the world's 
oceans and play a significant role in the transfer of energy and materials 
within the oceanic ecosystems. The major plankton subdivisions include 
bacteria, phytoplankton, and zooplankton.  

Primary Production: the amount of organic matter (usually expressed as 
grams of carbon per square meter per day) produced by organisms that are 
able to manufacture food from simple inorganic substances using energy from 
sunlight (in the case of photosynthesis) 

Pycnocline: A layer of water in which a high rate of change in density in the 
vertical dimension is present.  This layer of water has a high gravitational 
stability and thus physically isolates adjacent layers of water. 
 
Rhythmicity: describing a cyclical process. 
 
Thermocline:  A layer of water beneath the mixed layer in which a rapid 
change in temperature can be measured in the vertical dimension.  
 

Zooplankton- A diverse group of animals (usually tiny, but up to several 

meters in length for some jelly fish), that drift in aquatic environments. Several 

aquatic animals live out their life as part of the zooplankton (such as 

copepods and amphipods), while the egg and larval stages of some animals 

(such as crabs, clams and some fish species) are part of the zooplankton only 

until they grow large enough to start their adult life on the sea floor or other 

habitats. Zooplankton are also an important first tier of the food chain. 
 
 
 

https://oceanexplorer.noaa.gov/facts/photochemo.html
https://en.wikipedia.org/wiki/Tissue_(biology)
https://en.wikipedia.org/wiki/Transport
https://en.wikipedia.org/wiki/Carbon_dioxide
ftp://ftp.nodc.noaa.gov/pub/WOD05/DOC/WOD05plankton_Chapter14.pdf
https://oceanexplorer.noaa.gov/explorations/02arctic/background/education/media/arctic_productive.pdf
https://www.nwfsc.noaa.gov/sem/zooplankton.cfm
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PRE-ASSESMENT STRATEGY. 
 
To garner useful information on student knowledge of the biological carbon 
pump, students can trace a molecule of CO2 from the atmosphere through the 
ocean food web to look at the conversion of inorganic sources of carbon to 
organic ones and sources of return of inorganic carbon to the atmosphere. 
 
Key driving questions 
 

1. How is CO2 absorbed by the ocean? 
2. What is the process that phytoplankton use in the conversion of 

inorganic CO2 to organic CO2? 
3. What are the mechanisms by which CO2 is: a) returned to the 

atmosphere?  b) sinks to the deep ocean?  and c) used or consumed 
by other organisms? 
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LEARNING PROCEDURE  
 
Working With CTD Data 
 

A. Open the Excel File CTD_DATA_BIOS. You will see that there are 
three tabs at the bottom. CTD_TEMP; CTD_SALINITY and 
CTD_DENSITY. In the first tab Column A is “Temperature” and Column 
B is “Depth”.  

 
 

B. Select both columns A (temperature) and B (depth) by placing the 
cursor over the letter at the top of column A, holding down the mouse 
and moving it over to the letter at the top of column B. Both columns 
should be highlighted.  
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C. Click on the “Insert” tab on your Excel toolbar 
 

 
 

D. Select “X Y Scatter” Icon at the bottom right hand corner   
 

E. Select “Scatter with Smooth Lines” 
 

 
 

 
F. You will see a graph appear that looks like this and goes from the 

deepest measurement to the shallowest depth near the surface. We 
now need to flip the “Y” axis. 
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G. Click to highlight the “Y-axis” and then right click and choose “Format 
Axis” 

H. Tick the box that notes “Values in Reverse Order” 

 
 

I. Now the graph will read the temperature from the surface to 1000 meters 
 

 
 

J.  Next, click to highlight the “x-axis” and then right click and choose 
“Format Axis” 
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K.  You will also want to move your axis to the bottom of the graph. This is 
completed by choosing the “labels” tab and positioning the label as 
“high”. 

 
 

  
 
 

L. The graph will now look very similar to the one below    
 

 
 

 
M.  The next step is to label our “X” and Y” axis with the units of depth and 

temperature and give our graph a title by using the “Chart Design Tab” 
and selecting “Add Chart Element” to add both the axis and chart title 
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N. From this graph you will be able to identify the depth at the beginning 

of the thermocline. 
 

 
  

 
O. Repeat this process to create salinity (CTD_salinity) and density (CTD-

density) graphs. 
P. The density graph should look like the below. From here, identify the 

mixed surface layer and the beginning of the pycnocline. 
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Fecal Pellet Production 
 

A. The depth of the surface mixed layer has now been established and 
the next data set you will analyze will be fecal pellets produced by P. 
xiphias collected from four different time-points. There are 31 pellets to 
analyze and below is a table of the time, depth and number of pellets 
collected. 
 

 

Classification Depth Category 
Towing 
Depth Time 

Pellets 
produced 

Shallow tow mixed surface layer 
Surface-
200m 2AM 21 

Shallow tow mixed surface layer 
Surface-
200m 10PM 5 

Deep tow 
below the mixed surface 
layer 400-600m 9AM 4 

Deep tow 
below the mixed surface 
layer 400-600m 3PM 1 
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A. After opening Image J on your computer go to 

File → Open, and then open the file labeled 2AMstack 
(The file is provided alongside this lesson as a downloadable file .tiff 
file) This file contains 21 photos of fecal pellets from organisms at 2:00 
AM. 
 

B. Click on the line icon shown in the screenshot below  
 

 
 
C. Take this tool and draw a line from the start of the ruler on the board to 

1mm cm; this is going to be our “known measurement” and will allow us to 
Set the Scale. 

 
 

 
 

D. To set the scale now that you have your known measurement, select 
Analyze on your toolbar and Set Scale. This will give you a window like 
the one below. The computer has the known amount of pixels in the box to 
now equate with your known distance of mm. Make sure you add 1.0 mm 
as your known distance (this should be approximately 1mm=1589.47 
pixels). Select Global in this window and this will save the scale for this 
set of photos.   
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E. Now that the scale is set you can measure your fish pellet by taking your 

tool by taking the longest length and width of each pellet. You can then go 
to the toolbar and select Analyze → Measure (or Control + “m” /Apple 
“m”). When you are complete, there should be 42 measurements in the 
window. “a” is the major axis diameter and “b’ is the minor axis diameter. 
 

  

 
 
 
F. Your data file will look like this when you are complete in analyzing all 21 

pellet photographs. 
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G. Copy and paste these data into Excel and label your first tab 2AM. The 

column that we are interested in is the “length column” and other columns 
can be deleted. To calculate the volume of an ellipse you must know the 
radius of our two measurements. The radius is = to the diameter divided 
by two. r = d / 2 

 
H. To calculate the volume of each fecal pellet as observed we will follow the 

known factor that fecal pellets are predominately cylindrical, elliptical or 
near spherical. For this lab we will approximate fecal pellet geometry as an 
ellipsoid (Turner 2002; Shatova et al. 2012). “a” and “b: are the radii of the 
ellipses major radius and minor radius respectively. 

 
 
I. Calculate the volume of each fecal pellet and generate the average 

volume in mm3. Students will need to calculate the average fecal pellet 
volume in mm3, the standard deviation within each stack and the standard 
error for each time point 
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Excel Formulas 
 
=average for Average 
=STDEV for Standard Deviation 
=STDEV/Sqrt(sample size) for calculation of the standard error 
 
You will need your standard error for the addition of error bars for your 
graphs. 
 
J. Open the next stack file (eg. 9AM) and complete this process for the other 

3 timepoints. The scale should remain the same, but you may have to re-
set it. 

K. Generate a summary table and graph to compare fecal pellet volume 
across time points. There will be slight variation from student to student 

 
 

  
Fecal Pellet 
Volume 

2AM 0.0045 

9AM 0.0119 

3PM 0.0145 

10PM 0.0070 

  

  
 
L. After the summary table is complete students will create two bar graphs 

that address these two questions? 
 

1. Average volume of fecal pellets (mm3) produced by P. xiphias at four 
time points  

2. Number of fecal pellets produced by by P. xiphias at four time points 
 

 
 
 
 
 
 
 
 
 
 
 

  SE 

2AM 0.0003 

9AM 0.0053 

3PM 0.0000 

10PM 0.0037 
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ASSESSMENT AND EVALUATION 
 
Students will be asked to complete questions in the accompanying worksheet 
and attach their graphs. 
 
STANDARDS  
 
Next Generation of Science Standards l High School 
 
Disciplinary Core Ideas 
LS1.C: Organization for Matter and Energy Flow in Organisms 
• As matter and energy flow through different organizational levels of living 

systems, chemical elements are recombined in different ways to form different 
products. (HS-LS1-6),(HS-LS1-7) 

• As a result of these chemical reactions, energy is transferred from one system of 
interacting molecules to another. Cellular respiration is a chemical process in 
which the bonds of food molecules and oxygen molecules are broken and new 
compounds are formed that can transport energy to muscles. Cellular respiration 
also releases the energy needed to maintain body temperature despite ongoing 
energy transfer to the surrounding environment. (HS-LS1-7) 

 
LS2.B: Cycles of Matter and Energy Transfer in Ecosystems 
• Plants or algae form the lowest level of the food web. At each link upward in a 

food web, only a small fraction of the matter consumed at the lower level is 
transferred upward, to produce growth and release energy in cellular respiration at 
the higher level. Given this inefficiency, there are generally fewer organisms at 
higher levels of a food web. Some matter reacts to release energy for life 
functions, some matter is stored in newly made structures, and much is discarded. 
The chemical elements that make up the molecules of organisms pass through 
food webs and into and out of the atmosphere and soil, and they are combined 
and recombined in different ways. At each link in an ecosystem, matter and 
energy are conserved. (HS-LS2-4) 

 

Crosscutting Concepts 

Systems and System Models 
• Models (e.g., physical, mathematical, computer models) can be used to simulate 

systems and interactions—including energy, matter, and information flows—within 
and between systems at different scales. (HS-LS2-5) 

Energy and Matter 
• Changes of energy and matter in a system can be described in terms of energy 

and matter flows into, out of, and within that system. (HS-LS1-5), (HS-LS1-6)  
• Energy drives the cycling of matter within and between systems. (HS-LS2-3) 
 
 
 
 
 
 

http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=147
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=152
http://www.nap.edu/openbook.php?record_id=13165&page=91
http://www.nap.edu/openbook.php?record_id=13165&page=91
http://www.nap.edu/openbook.php?record_id=13165&page=91
http://www.nap.edu/openbook.php?record_id=13165&page=91
http://www.nap.edu/openbook.php?record_id=13165&page=94
http://www.nap.edu/openbook.php?record_id=13165&page=94
http://www.nap.edu/openbook.php?record_id=13165&page=94
http://www.nap.edu/openbook.php?record_id=13165&page=94


 

 Ocean Academy www.bios.edu 

 
Ocean Literacy Principles  
 
Principle 2: The ocean and life in the ocean shape the features of earth 

2D  The ocean is the largest reservoir of rapidly cycling carbon on Earth. Many 

organisms use carbon dissolved in the ocean to form shells, other skeletal parts, and 
coral reefs.  
 
Principle 3: The ocean is a major influence on weather and climate 

3E The ocean dominates Earth’s carbon cycle. Half of the primary productivity on 

Earth takes place in the sunlit layers of the ocean. The ocean absorbs roughly half of 
all carbon dioxide and methane that are added to the atmosphere.  

3F  The ocean has had, and will continue to have, a significant influence on climate 

change by absorbing, storing, and moving heat, carbon, and water. Changes in the 
ocean’s circulation have produced large, abrupt changes in climate during the last 
50,000 years.  

3G Changes in the ocean-atmosphere system can result in changes to the climate 

that in turn, cause further changes to the ocean and atmosphere. These interactions 
have dramatic physical, chemical, biological, economic, and social consequences.  

Principle 4: The ocean made earth habitable 

4C  The ocean provided and continues to provide water, oxygen, and nutrients, and 

moderates the climate needed for life to exist on Earth (Essential Principles 1, 3, and 
5).  
 
Principle 6: The ocean and humans are inextricably interconnected 

6A  The ocean affects every human life. It supplies freshwater (most rain comes from 

the ocean) and nearly all Earth’s oxygen. The ocean moderates the Earth’s climate, 
influences our weather, and affects human health.  
 
Principle 7: The ocean is largely unexplored 

7E Use of mathematical models is an essential part of understanding the ocean 

system. Models help us understand the complexity of the ocean and its interactions 
with Earth’s interior, atmosphere, climate, and land masses.  
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